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AlphaSmart Services

Please contact our Technical Services Center at 
(888) 274-2720 for technical questions or problems. 
You may also contact us by email at 
support@alphasmart.com.

To request a loaner AlphaSmart 3000, please call 
(888) 274-0680 or email loaner@alphasmart.com.

To purchase AlphaSmart products, see our online store
at www.alphasmart.com or call (888) 274-0680.

For general information or sales questions, please call 
(888) 274-0680 or email info@alphasmart.com.

Nothing in this manual may be reproduced in any manner, either whol-
ly or in part, for any purpose whatsoever without written permission
from AlphaSmart, Inc.
Copyright ©2001, AlphaSmart, Inc. All rights reserved.
Macintosh is a registered trademark of Apple Computer, Inc. 
Windows is a registered trademark of the Microsoft Corporation.
AlphaSmart is a registered trademark, and AlphaSmart Manager and
SmartApplet are trademarks of AlphaSmart, Inc. 



AlphaSmart Manager helps teachers and other AlphaSmart users
manage files and software on as many as 30 AlphaSmart 3000s
connected to an AlphaHub.

With AlphaSmart Manager, you can:

• Define the contents of AlphaWord files and send them to
connected AlphaSmarts.

• Retrieve AlphaWord files from connected AlphaSmarts and
save them individually or collectively.

• Maintain security by setting passwords in three different
areas.

• Keep track of the current number and status of connected
AlphaSmarts.

With AlphaSmart Manager and AlphaHub, you can configure an 
entire classroom set of up to 30 AlphaSmart 3000s with the same
files—story starters, language arts exercises, math drills—in one
easy operation. Retrieving files from all 30 AlphaSmarts takes
just a few mouse clicks instead of a separate operation for each
AlphaSmart. In addition, you can decide how you want the
AlphaSmarts set up to begin an activity, and save those settings
to be easily reused at any time.
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Three levels of passwords
In addition to providing control over some AlphaSmart options,
AlphaSmart Manager adds its own configuration password to
prevent unauthorized users from configuring AlphaSmarts. Do not
confuse this with the other passwords in the AlphaSmart system.

The configuration password is used within AlphaSmart Manager
to control downloading of configuration data to connected
AlphaSmarts. This password is optional and is not specific to a
single configuration, but (if set) must be entered each time you
want to download any configuration data to AlphaSmarts. (See
“Creating a configuration password” under “Configuring
AlphaSmarts” in “Chapter 5: Using AlphaSmart Manager.”) 

The master password cannot be changed using the AlphaSmart
Manager. It is set at the AlphaSmart factory and is used to enable
or disable the Password feature locally on an individual
AlphaSmart. (See “Chapter 7: Advanced AlphaSmart Features”
in the AlphaSmart 3000 User’s Guide).

The AlphaWord file password is stored in a configuration to
control AlphaWord file access. This password is optional and is

set through the “Passwords” option in AlphaSmart Manager. 
It is then passed to the AlphaSmarts during the "Configure
AlphaSmarts" operation, and must be entered by students before
they can access an AlphaWord file. Once students have used this
password to access their file, they can change the password for
their file to one of their own choice. See “Passwords (AlphaWord
file passwords)” under “AlphaWord Options” in “Chapter 3:
Defining an AlphaSmart Manager Configuration.”

All three passwords can be used independently of each other.
Changing one password does not affect the other two.

What is a configuration?
Using AlphaSmart Manager, you can customize your classroom
activities by creating individual configurations. You define 
settings and file contents for a particular activity and save that
information to a configuration file (denoted by the .acf
extension). When you are ready to conduct the activity, you 
send the contents of the configuration to all of the connected
AlphaSmarts.

For example, if you want your students to write an essay 
comparing the viewpoints of two different news stories, you can
download the text of the stories to two files on their AlphaSmarts,
place a sample outline for the essay in a third file, and the 
students can use File 4 for their writing. At the end of the exercise,
you can collect work from all of the students in a single step.

Or if you are using the AlphaSmart for spelling tests, you can
disable the Spell Checker on all AlphaSmarts.

Using AlphaSmart Manager to set these options has the same
result as setting them on an individual AlphaSmart. But using
AlphaSmart Manager is more convenient, because it allows you
to configure up to 30 AlphaSmarts for a particular activity at the
same time.

Building a configuration library
Re-using your configurations is just one convenient aspect of
AlphaSmart Manager. In fact, as you create configurations, you’ll
likely find yourself using them repeatedly over the course of your
teaching. As you build new configurations, you can save time and
effort by simply opening an old one and modifying it according to
your needs, then saving it under a new name.

6 AlphaSmart Manager



System Requirements
AlphaSmart Manager requires a Universal Serial Bus (USB)-
capable computer to connect to the AlphaHub, and runs on
Windows® 98se/98me, Windows 2000, and Macintosh® OS 8.6
or later versions that support USB devices.

AlphaSmart Manager requires an AlphaHub in order to
exchange files with AlphaSmarts. An AlphaHub is AlphaSmart’s
multiport management device to which you can connect a
Windows or Macintosh computer running AlphaSmart Manager,
and up to 30 AlphaSmarts. All connections are made through
USB ports. See “Chapter 4: Connecting to the AlphaHub.” To
send and retrieve files through an AlphaHub, each individual
AlphaSmart must be running AlphaWord v1.4 or later.

If your AlphaSmart has an older version of AlphaWord and
needs to be updated, you can obtain a newer version from the
AlphaSmart website at www.alphasmart.com/downloads, or by
contacting AlphaSmart, Inc. Contact information can be found
on the title page of this manual.

8 AlphaSmart Manager

Installing AlphaSmart Manager
AlphaSmart Manager is available for Windows and Macintosh.
Both installation and starting procedures are provided here.

Windows

1.Load the AlphaSmart Manager CD. The installation wizard
(a graphical step-by-step program) starts automatically.

2.Follow the installation wizard, accepting the default values.

3.When the program is finished installing AlphaSmart
Manager, restart Windows.

2
Chapter Two

Installing and Starting AlphaSmart
Manager
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The Configuration Window
The main window in AlphaSmart Manager is the Configuration
window, which is displayed when you start the program. This
window shows an open, unnamed configuration with empty
AlphaWord files and all options set to their factory default values.

Note: The graphics in this manual were created using the
Windows version of AlphaSmart Manager. Though they
appear slightly different on a Macintosh, all functionality is
the same.

10 AlphaSmart Manager

Use the Configuration window to create a configuration (.acf) which contains

options and AlphaWord files that are unique to a specific activity.

Macintosh
Note: Installing AlphaSmart Manager requires that you restart
your Macintosh after installation is finished. It is recommended
that you quit all other applications before installation.

1.Load the AlphaSmart Manager CD.

2.Double-click AlphaSmart Manager Installer.

3.Click Continue through the next two screens.

4.Select Easy Install. You may choose a specific location for the
installation by clicking Select Folder.

5.Click Install.

6.Click Restart to complete the installation.

Starting AlphaSmart Manager
Once you have installed AlphaSmart Manager, you can start the 
program by following these simple steps:

Windows

• Click on the Start menu and select Programs > AlphaSmart >
AlphaSmart Manager > AlphaSmart Manager.

Hint: You can create a Shortcut for AlphaSmart Manager and
copy it to your Windows desktop for easy access.

Macintosh

1.Double-click Hard drive > AlphaSmart Manager folder.

2.Double-click the AlphaSmart Manager icon.

Hint: You can create a Shortcut for AlphaSmart Manager and
copy it to your Windows desktop for easy access.
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You can change or clear the configuration password at any time,
as long as you know the current password.

On the other hand, if you set the “Passwords” option (in the
window, under AlphaWord Options) to “On,” you will activate
password protection on the connected AlphaSmarts when you
send the configuration. If, in addition, you select the checkbox
for “Set file passwords to:” and enter the word LEARN in the
text field, you will be defining a new password for the eight
AlphaWord files on each attached AlphaSmart. Once you 
download this configuration, your students will have to enter the
password LEARN before they can access an AlphaWord file on
their individual AlphaSmarts.

Once you understand this basic concept, you are ready to create
your own configurations and take advantage of the power and
versatility of AlphaSmart Manager.

12 AlphaSmart Manager

The Configuration window is divided into three sections:
AlphaSmart Options, AlphaWord Options, and AlphaWord Files,
which you’ll learn more about in “Chapter 3: Defining an
AlphaSmart Manager Configuration.”

AlphaSmart Manager Toolbar (Windows only)
The Windows version of AlphaSmart Manager contains a toolbar
which provides shortcuts to several functions.

The AlphaSmart Manager menu
The menu bar at the top of the Configuration window contains
several options—Open, Close, Save, Save As—that you’ll find in
many Windows and Macintosh applications.

However, there is one simple but important concept you must
understand about AlphaSmart Manager before you can use it
effectively. The menu options at the top apply to the entire
AlphaSmart Manager program, and the window options apply
only to the open configuration.

For example, if you click Set Password in the File menu (or in 
the Edit menu on a Macintosh), you will be prompted to set a
configuration password. Assume you set this password to the
word: LISTEN. The program will prompt you for the password
LISTEN every time you click Configure AlphaSmarts to send
configuration data. This not only prevents tampering, but it
avoids mistakes should more than one person have access to 
your computer.

Create a new
configuration

Save the current
configuration

Retrieve
files from

AlphaSmarts

About
AlphaSmart

Manager

Open an
existing

configuration

Set the
configuration

password

Check
connections
to AlphaHub
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You use AlphaSmart Manager to define settings and file contents for
a particular activity and save that information to a configuration
(denoted by the .acf extension). When you are ready to conduct the
activity, you send the contents of the configuration to all of the 
connected AlphaSmarts.

Defining a Configuration
A configuration (.acf) contains all the settings and files that apply
to a specific classroom activity. For example, you might define a
configuration for Beginning Language Arts, one for Intermediate
Language Arts, and one for Science, with each configuration 
containing up to eight AlphaWord files.

To define a configuration

1 Start AlphaSmart Manager to display the Configuration 
window.

2 Click File > Save As.

3 In the Save window, enter a name for your configuration (for
example, “Beginning Language Arts”).

That’s it! The name of your new configuration appears in the title
bar of the Configuration window. But your new configuration still
contains all the factory default settings, and its AlphaWord files
are empty.

3
Chapter Three

Defining an AlphaSmart 
Manager Configuration

AlphaSmart Manager 15



AlphaSmart Manager 17

Auto Repeat
When enabled (default), this feature causes automatic repeating
of a character after the key is held down for longer than about
one second. For example, if you hold down the letter “a” key for
an extended period of time, you would expect to see the letter
continually repeat itself on your screen (“aaaaaaa”). However,
with Auto Repeat off, you would see just one “a”, regardless of
how long you held the key.

Example: Let’s say you’re administering an activity to a classroom
of third-graders in which they are required to type in answers to
questions. Because their typing skills are likely at a beginner level,
it might be a good idea to turn off Auto Repeat so as not to
penalize the students for holding down a key longer than normal.
With more advanced students, you might decide to turn Auto
Repeat on to teach them to keep their fingers moving as they type.

Sticky Keys
With this feature enabled (default=disabled), you can type 
combination keystrokes without actually pressing the keys 
simultaneously. For example, you could press Shift-4 in sequence
(rather than holding down the Shift key) to get a dollar sign.

The Sticky Keys feature affects the four modifier keys: shift,
option, command (x), and control. When Sticky Keys is enabled,
pressing a modifier key effectively keeps that key “pressed down”
for the next keystroke.

16 AlphaSmart Manager

You use the Configuration window to define option settings for
the activity. The Configuration window is divided into three 
sections: AlphaSmart Options, AlphaWord Options, and
AlphaWord Files.

AlphaSmart Options
AlphaSmart Options are settings that apply to all operations of
the AlphaSmart 3000. No matter which SmartApplet is being
used, these settings will be in effect.

You can set unique AlphaSmart Options for each configuration
you create. The options you set here apply to all AlphaSmarts
that are used by the students who receive the configuration. 

Because your classroom activities cover a variety of subjects at
various learning levels, you’ll probably want to set up your 
configurations differently depending on each activity’s distinct

requirements. The AlphaSmart Options provide flexibility, allowing
you to customize each activity you administer to your students.

However, keep in mind that after you configure the AlphaSmarts,
the students using them can change your option settings on their
individual AlphaSmarts. For more information about these
options, see “Chapter 7: Advanced AlphaSmart Features” in the
AlphaSmart 3000 User’s Guide.

The AlphaSmart
Options you set here
apply to all functions
of the AlphaSmart.
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Keep in mind that all text is saved automatically when the
AlphaSmart powers off.

Slow Keys
This feature is designed to allow a user with unsteady hands or
difficulty in targeting specific keys to set a delay time between
pressing a key and the generation of the associated character. You
can turn Slow Keys off (default), or set it as high as 3 seconds.

The Auto Repeat delay, which is normally about one second, will
be increased to match the Slow Keys delay if it is greater than one
second. For example, a Slow Keys delay setting of 1.5 seconds
will set the Auto Repeat delay to about 1.5 seconds as well. This
means that, after pressing and holding a key down, there would
be a 1.5-second delay before a character appeared, and after an
additional 1.5 seconds, that character would begin to Auto
Repeat.

AlphaWord Options
AlphaWord Options are settings that affect operations specific 
to AlphaWord SmartApplet, the standard word processing 
program included with the AlphaSmart. Like the AlphaSmart
Options, you can customize the AlphaWord Options for each
configuration you create.

Show Marks
When this feature is enabled, pressing the tab key will produce
an arrow (→) on the AlphaSmart screen, and pressing the enter
key will produce a return arrow (↵ ) on the screen. This allows a
student to distinguish between tabs and spaces, and to know
where line breaks have been placed. When Show Marks is 
disabled (default), both characters appear as spaces on the screen.
Regardless of the Show Marks setting, both tabs and returns are
transferred to the computer as tabs and returns.

Calculator
When enabled (default), this feature lets you access the AlphaSmart
Calculator which is included in every AlphaSmart as a pre-installed
SmartApplet. You can use the Calculator on your AlphaSmart by
pressing the “applets” key and selecting “Calculator.”

Example: You’ll probably want to keep this option enabled unless
you are administering a math assignment in which your students
are required to perform their own arithmetic calculations.

Printer
This option lets you specify the type of printer your students will 
be using.

Each AlphaSmart is preloaded with printer drivers that are com-
patible with various popular printers. The choice you make here
simply tells the AlphaSmart which driver to use as the "active"
driver for print jobs. The default is “HP Printer.”

Keyboard Layout
You can choose from four different keyboard layouts to provide
for special education needs.

• QWERTY - (default) The standard layout of most keyboards
and typewriters.

• Dvorak - A scientifically designed key layout which requires
much less finger reaching and stretching for the most com-
monly used keys, and results in faster, easier typing.

• Right-handed - One-handed layout which enables faster typ-
ing for people with a disability that requires that they type
using only the right hand.

• Left-handed - One-handed layout which enables faster typing
for people with a disability that requires that they type using
only the left hand. 

Power Off Timeout
This feature lets you set the amount of time an AlphaSmart can
be idle before it is automatically powered off. The minimum idle
time is 4 minutes (default) and the maximum is 59 minutes.
(Some SmartApplets may override this setting to lengthen the
timeout period.)

18 AlphaSmart Manager
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IrDA Speed
This option sets the speed at which data will be transferred from 
an AlphaSmart to an infrared-capable device such as a printer 
or computer.

• Fastest (default) - Choose this mode for most computers and
applications.

• Compatibility Mode - Tells the AlphaSmart to transfer more
slowly. Choose this mode if you have a slower computer that 
cannot keep up with high-speed infrared transfers, and loses
data as a result.

Passwords (AlphaWord file password)
AlphaSmart Manager allows you to enable password protection
for all AlphaWord files. When you set the Passwords option to
“On,” the passwords that were last in effect for each file will be
in effect again. You can also reset all eight of the AlphaWord file
passwords to the same value, which you specify in the “Set file
passwords to” field. The factory default password is “write”. If
you change this, be sure to inform your students that the file
passwords have been reset.

AlphaSmart Manager cannot assign different passwords for each
file; this can only be done using the AlphaSmart itself.

Speed Recommended when using Compatible with

Slowest Resource-intensive apps All machines and
such as KidWorks and apps.
Student Writing Center.

Slow Mac Classic, Apple IIGS, All machines and
PC AT (286) most apps.

Fast Mac LC, 386-based PC, Most machines
(default) 486-based PC and apps.

Fastest Newer Mac OS machines, Many machines
Pentium-based PC and apps.

Spell Checker
When enabled (default) this feature allows a student to use
AlphaWord’s spell checker with its correction/suggestion capabilities
by pressing the “spell check” key. When an unrecognized word is
detected, the student is prompted to replace the word, ignore the
word, edit the word, or view the word in its context.

When Spell Checker is turned off, pressing the spell check key
while using AlphaWord will display the message: “Spell Check is
turned off.”

Transfer Speed
The AlphaSmart can send text faster than some older computers
and printers can accept it, resulting in missing characters or jumbled
text. Even on newer computers, some resource-intensive applica-
tions are slow to accept text. You can slow down the AlphaSmart’s
Transfer Speed to transfer text into these programs. You may have
to experiment to determine which speed best fits the machines and
applications you will be using for a specific activity.

20 AlphaSmart Manager
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Creating an AlphaWord file
To create an AlphaWord file, simply click the file’s corresponding
“Edit” button, enter your text in the file content window, and
click “OK.” You can also paste text from the Clipboard that you
have copied from another application.

Important: Your students’ AlphaSmarts must be equipped with
AlphaWord v.1.4 or later. Earlier versions will not operate with
AlphaSmart Manager. You can obtain the latest AlphaWord
version from the AlphaSmart website at
www.alphasmart.com/downloads.

The Configuration window will indicate the number of characters
the new file contains, as well as the first several words of the file
for easy recognition. The maximum file size is typically 25,600
characters for AlphaWord files, but can vary depending on which
other SmartApplets are installed.

To set a password for all AlphaWord files within a configuration

1.Set the “Passwords” option to On.

2.Mark the checkbox next to the words “Set file passwords
to.”

3.Enter a password between 1-6 characters. (The default 
password is “write”.)

Once you configure the AlphaSmarts with this setting, your 
students must enter this password into their AlphaSmarts in
order to access an AlphaWord file.

For more information about passwords, see “Chapter 7:
Advanced AlphaSmart Features” in the AlphaSmart 3000 User’s
Guide).

AlphaWord Files
AlphaSmart Manager lets you define the contents of any of the
eight AlphaWord files for each configuration you create. This
allows you to customize the files’ contents for any given activity.

For example, assume you are creating a configuration for 
administering language arts exercises for beginners. Each exercise
will consist of text to read in one AlphaWord file, with the next
file left empty for the student to write in. You name the file
Beginner Language Arts.acf and set up the AlphaWord files for
four different exercises. Your configuration might look something
like this:

22 AlphaSmart Manager

Each configuration can contain up to eight AlphaWord files.
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But remember, if you reset a file to its factory default values and
save that file, you cannot recover its previous settings. If you
change your mind after resetting a file that has been previously
saved, just close the configuration without saving, then re-open
the file.

24 AlphaSmart Manager

You must click through this confirmation dialog box to reset
all options to their default settings.

What are the checkboxes for?
You mark a file’s checkbox to indicate that you want to include
that file when you download the configuration to your students’
AlphaSmarts. If you unmark a file’s checkbox, that file is still
part of the configuration—it simply will not be downloaded
when you click “Configure AlphaSmarts” later on, leaving the
file’s current contents intact on the connected AlphaSmarts.

This may be helpful if you want to assign different writing 
activities for each day of the week. You could actually enter all
material at one time, but each day simply select the individual
files you want to work on for that day.

Maximum file size
The maximum file size an AlphaSmart can handle is typically
25,600 characters for a single AlphaWord file, but it can vary
depending on which SmartApplets are installed.

When you click “Configure AlphaSmarts,” the program checks all
attached AlphaSmarts to determine their maximum file size. If you
try to send an AlphaWord file that is too large for the AlphaSmarts
to handle, you will receive an error message and the download 
will not occur. Reduce the size of the large file, then repeat the 
configuration procedure.

Factory Defaults
Clicking this button will reset all settings for the open configuration
back to the original settings. This includes the AlphaWord files.
When you click “Factory Defaults,” the content is erased from
all eight AlphaWord
files in the open 
configuration. (The
AlphaSmarts themselves
will not be affected
until you click “Configure AlphaSmarts.”)

You’ll typically use this option when the configuration contains files
and settings that no longer apply to any of your school activities. 

Click this button to reset all settings and
files to their original default settings.
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To use AlphaSmart Manager, you must have a Universal Serial
Bus (USB)-capable computer connected to your set of
AlphaSmart 3000s through an AlphaHub.

An AlphaHub is
AlphaSmart’s multiport 
management device to which
you can connect a PC or
Macintosh (running
AlphaSmart Manager) and
up to 30 Alpha-Smarts. All
connections are made
through USB ports.

Checking Connections
AlphaSmart Manager
includes a status bar that
shows which AlphaHub
ports have an AlphaSmart
connected to them. This 
status bar can be displayed
using the Check Connection
function.

4
Chapter Four

Connecting to the AlphaHub

PC or Mac
running

AlphaSmart
Manager

USB

USB

AlphaSmarts AlphaSmarts

AlphaHub

When you click the “Configure

AlphaSmarts” button, the settings and file

contents defined in your .acf file are

downloaded to AlphaSmarts through the

AlphaHub.
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Now that you know how to create a configuration, it’s time to put
it to use by downloading its settings and files to your students’
AlphaSmarts. This operation is called “Configuring.”

Configuring AlphaSmarts
You can download a configuration to as many as 30 AlphaSmarts at
a time. The entire configuration process typically takes only a few
minutes to complete, but
it can vary depending on
the contents of your 
configuration and your
computer’s processing
speed.

Important: When you download your configuration to the 
connected AlphaSmarts, all settings, and the contents of any
AlphaWord files that are selected in the configuration, are 
overwritten. You can prevent data loss by either having your 
students copy the AlphaWord files they wish to keep to a 
computer, or by retrieving your students files (as described later
in this chapter) and saving them to your computer’s hard drive
before you perform the Configure AlphaSmarts operation.

Configuration does not change which SmartApplets are loaded
on the AlphaSmarts, and does not affect data in SmartApplets
other than AlphaWord.

5
Chapter Five

Using AlphaSmart Manager

Click this button to download your configura-
tion to your students’ AlphaSmarts.

This graphic shows 26 AlphaSmarts connected to the AlphaHub. Only four

ports—23, 24, 25, and 26—have no AlphaSmarts connected to them. On

your computer screen, a connected AlphaSmart is indicated by a green light.

To check the AlphaSmart connections

1.Click Check Connection in the Hub menu.

Hint: Windows users can click the Check
Connections icon on the toolbar rather than
going through the Hub menu.

2.The following dialog box is displayed.

This dialog box shows the status of all 30 AlphaSmart
connections. If an AlphaSmart is experiencing a connection
problem, make sure the USB cable is properly connected to
both the AlphaSmart and the AlphaHub, and the
AlphaSmart is powered on. If the problem persists, see
“Chapter 6: Troubleshooting.”

3.When you’re finished, click the X in the upper-right corner
to hide the status bar, OR you can leave the status bar
open while you use AlphaSmart Manager.

AlphaSmart Manager 29
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2. Enter a new password between 1-6 characters.
3. Click OK.The password is now set. You must enter this password

each time you click the “Configure AlphaSmarts” button.

For more information about passwords, see “Chapter 1: Introduction.”

Retrieving Files from AlphaSmarts
So far, we’ve discussed downloading settings and files in the form of
a configuration for a classroom activity. But what about turning that
around? Once your students have completed the activity, how do
they get their modified files back to you for grading or discussion?
Simple. Just retrieve them.

While your students can still individually transfer files to a computer
and save them there, the "Retrieve Files" option allows you to
retrieve files from all your students’ AlphaSmarts to your computer in
one operation. Files are retrieved as simple text files (.txt) and can be
opened, viewed, edited, and saved. Note: No text file will be created
for an empty AlphaWord file. Because you may be retrieving as many
as 240 different files (30 AlphaSmarts x 8 AlphaWord files each),
AlphaSmart Manager helps you organize them by copying the entire
hierarchical structure from the AlphaSmarts to your hard drive.

For example, when you choose the “Save All” option, all files down-
loaded from AlphaSmart #1 will be saved to the “AlphaSmart #1”
folder; files from AlphaSmart #2 will be saved to the “AlphaSmart
#2” folder, and so on. The number assigned corresponds to the
AlphaHub port number to which the AlphaSmart is attached.

Tip: You can number your AlphaSmarts 1-30, and assign each 
student a number to use throughout the year. When students finish
working with the AlphaSmarts, they connect them to the AlphaHub
cable with the matching number. This will result in the folder 
number described above matching the number on the AlphaSmart.

To retrieve files from AlphaSmarts

1.Make sure your AlphaHub is powered on.

2. In AlphaSmart Manager, click Retrieve Files in the
Hub menu.

Hint: Windows users can click the Retrieve Files icon on the tool-
bar rather than going through the Hub menu.

To configure AlphaSmarts

1.Make sure your AlphaHub is powered on.

2. In AlphaSmart Manager, open the configuration you want to
download. Note: If more than one configuration is open, only
the frontmost file will be downloaded.

3.Click Configure AlphaSmarts.

4.Enter the configuration password. If no password has been set, 
go to the next step. (See “Creating a configuration password” in
section below)

5.Click OK in the confirmation dialog box. The configuration
process begins and a progress box is displayed.

6.When all AlphaSmarts have been configured, a “success 
message” is displayed.

Creating a configuration password

You can set a configuration password that will prevent others from
using your computer to configure AlphaSmarts. A configuration 
password is not specific to a single configuration, but to your entire
AlphaSmart Manager program. If you choose to create a configura-
tion password, it must be entered every time a “Configure
AlphaSmarts” operation is performed from AlphaSmart Manager.

Because the configuration password creation procedure differs some-
what between Windows and Macintosh, both procedures are provided
here. 

Windows

1.Click the Set Password icon in the toolbar. 
—OR—
Click Set Passwords in the File menu.

2.Enter a new password between 1-6 characters.

3.Click OK.

Macintosh

1.Click Set Password in the Edit menu.
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When I click “Check Connections” it says that no AlphaSmarts
are currently connected.

• Make sure the power switch on the back of the AlphaHub 
is turned on. A green light on the front of the AlphaHub
indicates that the power is on.

• Make sure your computer is properly connected to the
AlphaHub.

• On Macintosh, use the System Profiler to see if the computer
is communicating with the AlphaHub. It will be listed under
Devices and Volumes as a USB Communication device
named Alphacart. If you don’t see this item, make sure that
the files USBAlphaSmartDrv and USBAlphaSmartShim are in
the Extensions folder of the System folder that is in use.

• On Windows, use the Device Manager to list hardware
devices. The AlphaHub will be listed under the AlphaSmart
heading.

I have an AlphaSmart connected to a port on the AlphaHub, but
when I click “Check Connections,” the indicator is black
instead of green. 

• Try plugging that AlphaSmart into the AlphaHub using a 
different USB cable.

6
Chapter Six

Troubleshooting

3.The download begins and a progress box is displayed.

4.When all files have been retrieved from connected AlphaSmarts,
the following dialog box is displayed.

5.Choose an option.

• View File – Lets you select and view the files individually 
without saving them to your hard drive. (This button is enabled
when you select a file.)
• Save File – Saves an individual file to your hard drive. (This
button is enabled when you select a file.)
• Save All – Saves all files—in their hierarchical structure—to
your hard drive. This process may take in excess of 45 minutes
if all eight files on all 30 AlphaSmarts are full and of the 
maximum size. You will discover what is normal for your usage,
but as a rule of thumb for more typical configurations, allow at
least ten minutes to retrieve files from 30 AlphaSmarts.

6.When you’re finished viewing and saving files, click Done.

You can click the “+” sign to show an AlphaSmart’s individual files. This
example shows an expanded view of AlphaSmart #3.



The “Configure AlphaSmarts” button is disabled (grayed out).

• Make sure the power switch on the back of the AlphaHub 
is turned on. A green light on the front of the AlphaHub 
indicates that the power is on.

• Make sure your computer is properly connected to the
AlphaHub.

• Make sure at least one AlphaSmart is connected to the
AlphaHub and powered on.

When I try to use AlphaSmart Manager Help, my browser
reports that it is unable to find a file or directory.

• Make sure the Help folder is in the same folder with
AlphaSmart Manager, and that the following documents are in
the Help folder:

- checkconn.html
- config.html
- main.html
- password.html
- retrieve.html

• If you are using a Netscape browser on a Macintosh, make
sure that no folder in the path to the AlphaSmart Manager
folder has a "/" character in its name.

I can’t remember the configuration password that I set, and now
I can’t use AlphaSmart Manager to configure my AlphaSmarts.

Call AlphaSmart, Inc. Customer Support at 888-274-2720 
for assistance.

34 AlphaSmart Manager

.acf – The extension attached to a configuration file created using
AlphaSmart Manager.

AlphaHub – A multiport hub device to which you can connect a
PC or Macintosh (running AlphaSmart Manager) and up to 30
AlphaSmarts. All connections are made through USB ports.

AlphaSmart Manager – The software that helps teachers and
other AlphaSmart users manage files and software on as many as
30 AlphaSmart 3000s connected to an AlphaHub. AlphaSmart
Manager runs on both Windows and Macintosh computers.

AlphaWord – A word processing SmartApplet that is built into
an AlphaSmart. AlphaWord offers popular features such as 
spell check, cut/copy/paste, find, and autosave.

AlphaWord file password – The password that protects
AlphaWord files from intruders. The AlphaWord file password is
set through the “Passwords” option in the AlphaWord Options
area in AlphaSmart Manager.

Calculator – A calculator SmartApplet that is built into an
AlphaSmart. Calculator offers popular features such as addition,
subtraction, multiplication, division, exponentiation, and group-
ing using parentheses.

compatibility mode – An IrDA speed option. When you choose
“compatibility mode,” you are telling the AlphaSmart to “type
slowly.” Choose this mode if you have a slower computer that

Glossary
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master password – The password that controls access to certain
settings from the AlphaSmart itself. This password is originally set
by AlphaSmart, Inc. during manufacturing. You are prompted to
enter this password when you use a keyboard command on the
AlphaSmart to turn on AlphaWord file passwords, for example.

retrieve – To acquire data from a peripheral device to a main
source. In AlphaSmart Manager, data entered by students is
retrieved from connected AlphaSmarts to the computer that is
running AlphaSmart Manager.

SmartApplet – An application that runs on an AlphaSmart.
AlphaWord and Calculator are examples of SmartApplets.

transfer speed – The speed at which an AlphaSmart sends data
via a cable connection to a computer. Older computers may not
be able to handle data transfer as fast as newer devices. You can
adjust this speed using the “Transfer Speed” option which is
found in the AlphaWord Options section of the Configuration
window in AlphaSmart Manager.

USB - Universal Serial Bus. An external communications bus stan-
dard. AlphaSmart devices (including AlphaHubs and computers
running AlphaSmart Manager) are connected with each other
through USB cables.

may have a hard time keeping up with high-speed infrared transfers.

configuration – A configuration (.acf) is a file that contains all
the settings and AlphaWord files that apply to a specific classroom
activity. When you click “Configure AlphaSmarts” you send the
configuration data (not the configuration file itself) to the con-
nected AlphaSmarts.

configuration password – The password that prevents intruders
from using the AlphaSmart Manager configuration process. This
password is used within AlphaSmart Manager to let you down-
load a configuration to connected AlphaSmarts. If it is set, you
will be prompted to enter this password when you click
“Configure AlphaSmarts.”

download – To copy data from a main source to a peripheral
device. In AlphaSmart Manager, configuration data is downloaded
from the computer that is running AlphaSmart Manager to the
connected AlphaSmarts.

factory defaults – The configuration settings that are programmed
during the AlphaSmart manufacturing process. For example, the
factory default for the Keyboard Layout is QWERTY.

fastest mode – An IrDA speed option. When you choose
“fastest” mode, you are telling the AlphaSmart to transfer text at
its highest IrDA speed. If you find that text is garbled or missing,
switch to “compatibility mode.”

IR – Short for infrared. The IR designation (e.g. AlphaSmart 3000
IR) signifies that the AlphaSmart contains infrared technology,
which allows you to transfer files to a printer or computer with-
out using cables.

IrDA speed – The speed at which data is transferred from an
AlphaSmart to an infrared-capable computer. On the AlphaSmart,
the IrDA speed can be set to “fastest” or “compatibility mode.”
(“IrDA” is short for “Infrared Data Association,” a group of
device manufacturers that developed a standard for transmitting
data via infrared light waves.)
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